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About This Guide 

Introduction 

This guide provides information to help you get started using the IPTV Services 
Delivery System (ISDS) to manage the IPTV Services Delivery Platform (ISDP). 

Important: This guide is written in conjunction with the ISDS Help system. 
 

Purpose 

The purpose of this guide is to introduce the ISDS so that users can use it to manage 
their ISDP Platform. After reading this guide, users will be able to do the following: 

 Understand how the ISDS fits into the ISDP and how to use the ISDS graphical 
user interface (GUI) 

 Start up the ISDS workstation 

 Understand network maps and how to maintain them 

 Access the ISDS Help system to find detailed procedures for performing specific 
tasks on the ISDS 

 
 

Audience 

This guide is intended for system operators and Cisco Services engineers who are 
provisioning ISDS in an ISDP environment. 
 

Scope 

This guide provides an overview for using the ISDS software with ISDS 1.0. This 
guide does not describe the ISDS hardware or how to set up the ISDS hardware. 

For information about features and enhancements included in your specific system 
release, refer to the appropriate set of release notes. 

For steps on completing specific tasks, refer to the ISDS Online Help (UNIX Version) 
(part number 4021161).*   

*The Unix version of the online help should be installed on the ISDS. The PC version 
of the online help ISDS Online Help (PC Version) (part number 4021162) is a separate 
CD that allows you to view the same online help on a PC separate from the ISDS 
workstation.   
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Before You Begin 

Before you begin using the ISDS, you should have your network map(s) readily 
available. Network maps provide detailed information about the equipment layout 
of a site. If you cannot locate your network map(s), contact Cisco Services. 
 

 

Document Version 

This is the second formal release of this document. 
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The ISDS provides the video application infrastructure in an ISDP. The 
ISDS transmits system and programming information through the 
ISDP to set-tops and other compatible set-top converters. By using the 
ISDS, you can provide digital broadcast, as well as interactive services 
to your subscribers. 

This chapter describes the role of the ISDS within the ISDP. This 
chapter also discusses how to use primary ISDS graphical user 
interfaces (GUIs), specifically the ISDS Administrative Console Status 
window and the ISDS Administrative Console window. This chapter 
explains how to use the ISDS Help system to find additional 
information and detailed procedures for specific tasks. 

Note: Depending on your system release, the illustrations and options 
you see in this guide may not exactly match those on your system. If 
you have questions about the capabilities of your system, contact the 
representative who handles your account. 
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What Is ISDS? 
An ISDS is a server that is typically installed in a headend and is connected to the 
ISDP. The ISDS provides information about each element in a ISDP and allows 
elements to communicate with each other. By communicating with these elements, 
the ISDS allows operators to provide subscribers with many types of digital cable 
services, including the following: 

 Video-on-demand (VOD) 

 Internet services  
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How the ISDS Fits Into the ISDP 
This section briefly describes the ISDS and how it fits into the ISDP. 
 

ISDP Components 

The ISDP is a network of hardware and software elements that connect content 
servers to set-tops to deliver video, audio, digital data, and applications to 
subscribers using the TCP/IP protocol. The ISDS provides information about 
elements in the ISDP network.  

The following diagram illustrates how various elements interconnect to form the 
ISDP network. 
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How the ISDS Communicates with Other ISDP Elements 

For the ISDS software to recognize and communicate with other ISDP elements, 
operators complete specific tasks from the following two ISDS user interfaces. These 
interfaces also allow operators to define, manage, and monitor most elements and 
services of an ISDP: 

 ISDS Administrative Console Status interface 

 

 

 ISDS Administrative Console interface 

 

For more detailed information on these interfaces, refer to Monitoring and Managing 
the ISDS (on page 27) and to the online Help. 
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Finding Your Software Versions 
To find the software version for each package that is installed on your ISDS, click 
Help and Version on the ISDS Administrative Console window. 
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The system will take a few seconds to generate a list of the software packages and 
their associated versions. 
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Accessing Online Help for the ISDS 
The Online Help provides information about a window or task that you want to 
perform on the ISDS. You can access the Help for the ISDS in one of the following 
ways depending upon the type of window that is displayed. 

 From a drop-down menu 

 From a hyperlink on a window 

 From a button on a window 
 

Accessing Online Help From a Drop-Down Menu 

Some of the windows on the ISDS are displayed as a menu-based GUI. You access 
the online Help for these windows from a drop-down menu. 

To access the Help from a drop-down menu, complete the following steps: 

1 From the ISDS Administrative Console window, click Help and select Online 

Help. 

 

Result: The Welcome page for the Help opens with the Table of Contents in the 
forefront. 

2 Use the books under the Contents tab or access the Index or Search feature to 
find the information you need. 
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Accessing Online Help from a Hyperlink on a Window 

Some of the windows on the ISDS are displayed in a Web User Interface (WUI). 
Instead of menus, these WUI windows use hyperlinks to take you from one window 
to another.  

To access online Help from a hyperlink on a WUI, click Help > This Window in the 
side pane of the window. The specific Help topic for that window opens.  

To access online Help from a hyperlink on a WUI, complete the following steps:   

1 From the ISDS Administrative Console, click the System Provisioning tab and 
then click IP Source Definitions. The IP Source Definitions window opens in a 
web browser. 

 

2 Click Help > This Window to display specific information about this window 
and the tasks you can perform, such as finding out the source ID for specific IP 
sources.  
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Accessing Online Help from a Button on a Window 

Some of the windows on the ISDS have Help buttons on the window where you are 
performing a task. 

To access Help from a button on a window, complete the following steps: 

1 From a specific window (for example, the Package List window), click Help.  

 

Result: The Welcome page for the Help opens with the Table of Contents in the 
forefront. 

 

2 Use the books under the Contents tab or access the Index or Search feature to 
find the information you need. 
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Using the Help to Find Information About the ISDS 
The ISDS online Help provides a table of contents, index, keyword search, and a 
glossary that you can use to quickly find information about the ISDS.  

To view the table of contents, index, keyword search, and glossary, follow these 
steps:      

1 Click the Contents tab to display a list of topics. Click a book topic to expand its 
contents. 
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2 Click the Index tab and type a keyword to display a list of related topics. You can 
also click the Index button at the top of a help page to display the index.  
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3 Click the Search tab and type a keyword to display a list of related topics. 
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4 Click the Glossary of Terms book to display an alphabetical listing of terms and 
their definitions.  
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Search Tips 

Follow these steps to use the Search feature.  

1 In the left pane, click the Search tab and enter one or more key words in the 
Search field. 

 

 

Notes:   

 Searches are not case-sensitive, so you can type your search in uppercase or 
lowercase characters.  

 You may search for any combination of letters (a-z) and numbers (0-9). 

 To search for an exact phrase, group the elements of your search using 
double quotes to set apart each element. For example, to search for 
information about the window Set Up ISDS BFS Host, enter "Set Up ISDS BFS 
Host" in the search field. This ensures that the system looks for this exact 
phrase. On the other hand, entering Set Up ISDS BFS Host in the search field 
causes the system to look for topics that contain any of these four words. 

2 Click Go or press Enter. Help searches all topics containing the word (or words) 
you entered and displays the results of the search. If Help finds topics containing 
the word (or words) you entered, the topics are listed below the Search field.    

Note:  This method can help you find a topic (if you know its title), or every 
instance of a concept or feature in the system.  

3 Use one of the following methods to display a topic that appears in the list: 

 Click twice on any topic in the list. 
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 Click on a topic and then click Display.  

 
 

Quick Paths 

A Quick Path is provided at the beginning of many Help procedures to help you get 
to a specific window to perform a procedure. The following example shows the 
Quick Path for adding a source definition. 

 

As you become more experienced in using the ISDS, these Quick Paths may be the 
only reminders you need to perform certain tasks. 

In this example, you would use the Quick Path to perform the following steps. 

1 On the ISDS Administrative Console, click the ISDS tab. 

2 On the ISDS tab, click the System Provisioning tab. 

3 On the System Provisioning tab, click the Source button. The Source List 
window opens. 

4 On the Source List window, click File and New. The Set Up Source window 
opens. 

5 Enter a source name and source ID for the video source. 

Note: The Source ID must be greater than 200. IDs that are 200 or less are 
reserved for BFS sources. 
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6 Enable or disable the Enable EAS Channel Suppression option, as needed. 

7 Click Save. 
 

Window Tips 

Use the following tips to help you perform tasks from the windows on the ISDS and 
find information in the Help: 

 To return to a Help topic you have previously visited, right-click on the window 
and click Back.  

 Occasionally, a Help topic may not display properly. This is especially true if you 
try to resize the Help window. If this happens, simply close the Internet browser 
and then re-open it. 

 In many cases, you can press the Enter key on your keyboard and have the same 
effect as clicking OK or Save in a window. 

 To open a window for an existing item, the procedures in this Help system 
advise you to click once on the item name and then click File > Open. If you 
prefer, in many instances you can double-click on the item name to open the 
window. 

 

xterm Windows 

An xterm window lets you enter UNIX commands to manipulate, view, and edit 
various program files within the ISDS operating system. 

To open an xterm window, complete the following steps. 

1 On the ISDS Administrative Console, click the Utilities tab. 

2 Click xterm. An xterm window opens and displays the prompt associated with 
your User ID. For example, if you are logged in as a root user, the xterm window 
displays a root user prompt ($). 

Enhanced security features, including role-based access control, have been 
implemented for ISDS. This means that you cannot log in to the system using the 
dncs User ID; dncs is now a role that you can assume by typing su - dncs at a system 
prompt. You can read the enhanced security section of the Initial Installation and 
Upgrade Instructions for the ISDS (part number 4028676) to learn more about ISDS 
security.  
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Securing Your ISDS 
To protect system security, a Solaris feature exists that forces the ISDS monitor to go 
blank if there is no activity on the ISDS for a specified length of time (default=10 
minutes). When the monitor goes blank, complete the following steps to unlock your 
ISDS. 

1 Move the mouse or press any key to bring up the password window. 

2 Type the password and click OK to return to the ISDS desktop. 

Notes:   

 If the ISDS Administrative Console window does not open, click the middle 
mouse button and select Administrative Console from the menu that appears. 

 For details about creating secure passwords, refer to the section on security in the 
Initial Installation and Upgrade Instructions for the ISDS (part number 4028676).  

 

Limiting Access to the ISDS 

You can create other users who can access the ISDS and limit the access to what they 
can use. For information on creating users and setting up access, refer to the ISDS 
Online Help (PC Version) (part number 4021162) 
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Generally, the ISDS operates continuously until you stop it manually 
to upgrade it or to perform maintenance activities. If you are 
upgrading the ISDS, do not use the procedures in this chapter to 
restart the ISDS after the upgrade. Instead, use the procedures 
provided in the upgrade installation instructions that came with the 
system release. 

Use the procedures in this chapter if you are starting up the ISDS for 
the first time, or if power to the ISDS is interrupted. 
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Start-Up Sequence 
For the ISDS to function properly, you must start up its components in the following 
sequence. Each of these procedures is described in detail in this chapter. 

1 Power up the ISDS workstation. 

2 Start the ISDS processes. 

3 Choose one of the following options: 

 If you are using ISDP 2.5 or later, start the Application Server and its 
processes as described in the Initial Installation and Upgrade Instructions for the 
ISDS (part number 4028676)    

 If you are using an application server from a vendor other than Cisco, power 
up the application server according to the documentation that came with it. 
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Powering Up the ISDS Workstation 
The first step in starting up the ISDS is to power up the ISDS workstation as 
described in this section. 

Important: Before you begin this procedure, you must have your login password. If 
you do not have your login password, contact your system administrator. 

To power up the ISDS workstation, complete these steps.  

1 Go to the ISDS workstation and press the Power button. After the system 
finishes its start-up process, the login window opens with a welcome message. 

Note:  Depending on your ISDS model, the power button could be on the back of 
the ISDS or on the front, possibly under a panel that you open. Some models 
have a key that you turn to the "On" position, which is indicated by a vertical line 
(|). 

2 Log in as a DNCS administrator. The password prompt appears. 

3 Type the password and press Enter. The ISDS desktop appears. 

4 Using the mouse, place the cursor anywhere on the ISDS desktop and click the 
middle mouse button. A menu appears with a list of options. 

5 Click Administrative Console. The ISDS Administrative Console and Status 
windows open. The ISDS workstation is now completely powered up. 

6 Your next step is to start the ISDS processes. Go to Starting ISDS Processes (on 
page 22). 
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Starting ISDS Processes 
After you power up the ISDS workstation, you can start the ISDS processes that 
control the ISDS software. These processes are an integral part of the ISDS software. 
You cannot use the system until you start these processes. This section covers both 
ways to start ISDS processes: 

 Start all processes on the ISDS 

 Start an individual process on the ISDS 
 

Start All Processes 
1 On the ISDS Administrative Console Status window, click the Control button in 

the ISDS area. 

 

Result:  The ISDS Control window opens with a list of all the ISDS processes and 
their working states. A green state indicates that a process is running, and a red 
state indicates that a process is not running. 

 

2 Use the mouse to place the cursor in an unoccupied area on the ISDS desktop 
and then click the middle mouse button. The ISDS menu opens. 

3 Click ISDS Start. On the ISDS Control window, all of the processes change to a 
green state, which indicates that they are running. 

Note: It may take several minutes before all processes show a green state. 

4 Start the application server. Choose one of the following options: 

 If you are using ISDP 2.5 or later, start the Application Server and its 
processes as described in the Initial Installation and Upgrade Instructions for the 
ISDS (part number 4028676). 

 If you are using an application server from a vendor other than Cisco, power 
up the application server according to the documentation that came with it. 
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Start an Individual Process 
1 On the ISDS Administrative Console Status window, click the Control button in 

the ISDS area. The ISDS Control window opens with a list of all the ISDS 
processes and their working states. A green state indicates that a process is 
running, and a red state indicates that a process is not running. 

 

2 Select the process that you want to start. For example, bossServer is selected in 
the following example. 

 

3 Click Process and select Start Process. The process is started. 
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Stopping the ISDS Process 
It is recommended that you restart the ISDS every month as a normal maintenance 
process to free up system memory, swap space, and so forth. Part of that 
maintenance process involves stopping all ISDS processes. In other cases, you may 
want to stop an individual process. This section covers both methods.  

 Stop all processes on the ISDS 

 Stop an individual process on the ISDS 

Note:  For detailed information on restarting the ISDS, refer to the ISDS online help. 
 

Stop All Processes on the ISDS 

Important: If you are restarting the ISDS, complete this procedure only after you 
stop the Application Server process. Restarting the ISDS in the incorrect order could 
cause some processes to function incorrectly. Refer to the Initial Installation and 
Upgrade Instructions for the ISDS (part number 4028676) to learn how to stop and 
restart the ISDS.  

1 On the ISDS Administrative Console Status window, click the Control button in 
the ISDS area.  

 

Result: The ISDS Control window opens with a list of all the ISDS processes and 
their working states. A green state indicates that a process is running and a red 
state indicates that a process is not running. 

 

2 Use the mouse to place the cursor in an unoccupied area on the ISDS desktop 
and then click the middle mouse button. The ISDS Menu opens. 
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3 Click ISDS Stop. The ISDS begins shutting down all of its processes. This 
process can take from 5 minutes to an hour to complete depending on the size of 
your system, how many sessions are active, and so forth. When finished, all of 
the processes listed on the ISDS Control window should have a red working 
state, which indicates that they are not running. In addition, the ISDS area of the 
ISDS Administrative Console Status window will change to "Inactive." 

4 Open an xterm window on the ISDS. 

5 At the prompt, type dncsControl and press Enter. The dncsControl main menu 
opens in another xterm window. 

6 Type 2 to select Startup/Shutdown Single Element Group and press Enter. The 
system displays a list of all ISDS processes, along with their current working 
states ("running" or "stopped"). 

7 Press Enter to update the working states of the ISDS processes. Continue to press 
Enter every few seconds until all processes show Curr Stt: stop(1). 

Important: Wait until all processes are stopped before you continue with other 
activities on the ISDS. 

8 Type x and press Enter to return to the dncsControl main menu. 

9 Type x and press Enter again to close the dncsControl main menu. 

10 Click the bar in the upper left corner of the xterm window and click Close to 
close the window. 

 

11 Are you in the process of restarting the ISDS? 

 If yes, your next step is to restart all ISDS processes. Go to Start All Processes 
(on page 22) for details on restarting all processes. 

 If no, you are finished with this procedure. 
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Stopping an Individual Process 
1 On the ISDS Administrative Console Status window, click the Control button in 

the ISDS area.  

 

Result: The ISDS Control window opens with a list of all the ISDS processes and 
their working states. A green state indicates that a process is running and a red 
state indicates that a process is not running. 

 

2 Select the process that you want to stop. For example, the bossServer is selected 
in the following example. 

 

3 Click Process and select Stop Process. 

4 When the system prompts you to stop the process, click Yes. This step can take 
several minutes to complete depending on the size of your system, how many 
sessions are active, and so forth. When finished, the process listed on the ISDS 
Control window should have a red working state, which indicates that the 
process is not running. 
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The ISDS transmits system and programming information through 
your ISDP to set-tops and other compatible set-top converters.  

From the ISDS GUI, you can set up, change, manage, and monitor 
most elements and services of an ISDP. The following two windows 
are always present on the ISDS and allow you to monitor and manage 
most elements and services of the ISDP: 

 ISDS Administrative Console Status 

 ISDS Administrative Console 

This chapter introduces you to the tools you can use to monitor and 
manage the ISDS. 
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Checking the Status of the ISDS 
The ISDS Administrative Console Status window lets you check the status of the 
ISDS. 

 

The ISDS section of the Administrative Console Status window indicates whether 
the ISDS software is in operation based on the following conditions: 

 Running—the ISDS software package is present and in operation 

 Inactive—the ISDS software package is present, but not in operation 

In addition, when you click the Control button in the ISDS section, the ISDS Control 
window opens, which allows you to monitor all of the major ISDS processes. 

 
 

 
CAUTION: 

Do not attempt to start or stop an ISDS process manually unless a Cisco 
Services representative specifically tells you to do so. Otherwise, you could 
disrupt services to your subscribers. 

For detailed information on the ISDS Administrative Console Status interface, refer 
to the ISDS Online Help. 
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Checking the Status of Other ISDS Elements 

Status of Application Server 

The ISDS Administrative Console Status window lets you check the status of the 
Application Server (AppServer). If the Application Server software is operating, the 
ISDS Administrative Console Status window displays Running in the AppServer 
field. If your system does not use the Cisco Application Server, the AppServer area 
shows either a blank status or a status of Not Installed and the Control button is not 
usable. 

 

When you click the Control button in the AppServer section, the AppServer Control 
window opens. Use this window to monitor all of the major application server 
processes. 

 
 

 
CAUTION: 

Do not attempt to start or stop an AppServer process manually unless a Cisco 
Services representative specifically tells you  to do so. Otherwise, you could 
disrupt services to your subscribers. 
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Managing the ISDS 
The ISDS Administrative (Admin) Console window is the primary window you use 
to work with the ISDS. The Admin Console is divided into the following three tabs 
that allow you to perform activities related to various aspects of the ISDP. 

 ISDS 

 Application Interface Modules 

 Server Applications  

Note: For detailed information on the ISDS Administrative Console interface, 
refer to the ISDS online Help 

 
 

ISDS Tab 

The ISDS tab on the ISDS Administrative Console allows you to manage the 
following areas of the ISDP: 

 System Provisioning—accessing this tab allows you to manage the following 
areas of the ISDS: 

- Service Provisioning:  add sources, source definitions, and packages 

- System Management: add users and define user access, define bandwidth 
management rules, and set up daylight saving time rules 

 Network Element Provisioning—accessing this tab allows you to set up 
hardware elements (for example, headends, hubs, clusters) in your system 
(excluding set-tops) 

 Home Element Provisioning—accessing this tab allows you to manage the 
devices deployed within a subscriber's home. Access to this screen should be 
limited to specific users.  
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 Utilities—accessing this tab allows you to perform the following tasks: 

- Monitor the performance of your system 

- Run various reports to see how the system is functioning 

- Access the Logging utility to set log levels for processes, determine how 
specific flow types are set up at the network level, and open an xterm 
window to perform troubleshooting activities 

 

Application Interface Modules Tab 

The Application Interface Modules tab on the ISDS Administrative Console provides 
an interface between the server applications and the set-tops. Key features include: 

 Managing BFS servers, sources, and hosts 

 Managing CSM services  

 Defining the configuration for communicating service operation attributes to the 
set-tops in the network 

 Managing new servers, directories, files, and links to the BFS which allow set-
tops to access application information 

 Defining channel maps and how they will map to specific hubs 
 

Server Applications Tab 

The Server Applications tab on the ISDS Administrative Console provides access to 
applications that reside on the Application Server. You can use the buttons on this 
tab to configure services associated with these applications. The options that appear 
on this tab vary depending on the applications available on your system (for 
example, the Interactive Program Guide (IPG), Virtual Channel Service (VCS), or 
Languages).  
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If You Have Questions 

If you have technical questions, call Cisco Services for assistance. 
Follow the menu options to speak with a service engineer. 

Access your company's extranet site to view or order additional 
technical publications. For accessing instructions, contact the 
representative who handles your account. Check your extranet site 
often as the information is updated frequently. 
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